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We're the Macomb Intermediate School District. We exist to provide our clients quality service, high caliber
support and cutting edge leadership.

Our primary clients are the 21 school districts of Macomb County. They are our most important customers--
indeed, our reason for being.

Within these districts we focus our efforts on school staff. We work to increase their skills and capabilities so their students can
experience more effective educational programs.

We also serve students with disabilities. In fact, we are committed to working directly with youngsters with
disabilities who reside in Macomb County’s school districts.

And we are involved with the educational community across the country. Many of our staff members are
deeply involved in state and national programs. Many are working with colleges and universities. Still
others are exchanging information with their professional colleagues. All these activities have a single
purpose: to identify and develop techniques and programs which improve learning opportunities in Macomb
County.

This is the professional focus which makes the Macomb Intermediate School District one of America’s
premier regional education agencies.

The MISD is an equal opportunity employer. It is the policy of the MISD that no person on
the basis of race, creed, color, religion, national origin, age, sex, height, weight, marital
status, or disability shall be discriminated against, excluded from participation in, denied
the benefits of, or otherwise be subjected to discrimination in any program or activity for
which the MISD is responsible.

The MISD will provide, upon request with advance notice, appropriate auxiliary aids and
services necessary to afford a qualified individual with a disability equal opportunity to
participate in the services, programs and activities conducted by the MISD. To request
auxiliary aids or services, contact Rosetta Mullen, 586/228-3309. MISD Text Telephone
(TTY) 586/286-8040.



Advantages of Elementary Schools Using Schedules
Elementary schools that use schedules have the following options available to them:

Ability to print student schedules, class schedules and teacher schedules

Ability to produce attendance add-drop reports and other detailed attendance reports
Ability to use grade reporting (progress reports/report cards)

Ability to use the Walk-In Scheduling atom

Although using schedules requires some additional setup such as creating courses and
sections, once created, these files can be rolled from year to year.

Below is an example of the SASI Classes atom, which reflects the student’s section and
course in which she is enrolled in.
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For further information on elementary scheduling setup and process, please refer to the
documentation provided.
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Course Description

This course teaches you to create teacher, course, and section records. It will also explain
the scheduling process associated with an Elementary School with schedules.

Expected Outcomes

Upon Completion of this course you will be able to:

Set up the correct fields in the School atom.

Add, inactivate and delete teacher records using the Teacher atom.

Add, inactivate and delete courses using the Course atom.

Add and Duplicate Sections for both Primary and Special Teachers.

Create Student Class List atoms to be used to enroll students into Sections (classes).

Create Teacher Class List atoms to be used to enroll new or individual students into
classes.

School Atom

Elementary, With Schedules

When this type is selected, SASIxp works with the Sections, Course, and Schedule atoms
as well as the Teacher atom. For example, the program refers to the Sections atom when
users find Class Attendance records. It looks for Teacher numbers in the Master Schedule
(AMST) file when users sort Class Rosters and Attendance reports.

On the Schedule Tab of the School atom make sure that the School Type is Elementary, With
Schedules

=  Elementary Demo i =
Sch# <l School Mame AlternateR Sch Abry Telephone
|EI'EIE Elemenrtary Demo Eletn 999-123-9576
Basic |  oeneral Secondary ion | Localization

Elementary, Mo Schedules
v’ Elementary , With Schedules

School Type |Elemer|tar':.-',

= s e

Some other fields that need to be set up in the School atom are also found on the Schedule Tab
of the School atom.



Elementary Demo =
Schi <] School Mame Alternated Sch Abry Telephone
|EIEIE! Elemertary Demo Eletm 993-123-9376

Basic |  General Schedule Enrolinert | Term Duration | Locatization |
School Type |Elemer|tar':.-', Witk Schedules - Course Length 3

Section ID Length =1

Zen. Section 1D |Cu:uurse & Manual - Homeroom Period

Term Type |‘r‘ear Schedule - Teacher Aide

Gen. Section 1D How section IDs are to be generated. (It is suggested that you choose the
Course & Manual discussed below.)

Course & Manual Tells the program to automatically assign the first portion of each section
ID, using course numbers. Users can then complete the IDs with additional numbers as
needed.

Course Length Maximum number of characters allowed for course IDs. You can allow up to
14 characters for course IDs. (3 or 4 suggested here)

Section ID Length Maximum number of characters allowed for class or section IDs. Specify
by typing a number from 1 to 18. (6 or 7 suggested here)

On the General Tab of the School atom, the Period fields need to be filled in to reflect the number of
subject areas you need to define in the Course atom. For 11 subjects (courses) the following Periods
should be filled in. Begin 01, End 11.

Basic Ceneral I =
Srade Levels Taught
oo o1 02 0z 04 05 05

Promote Grade Level to
o1 02 03 04 05 065

Periods; Paz=word:
Begin |D1 rinimum Lencth
End |1 1 Craves 1o Expiratic

The Term Duration Tab of the School atom is where the start and ending dates are entered for
each term. (This is where the default date is found for starting dates in the Sections atom before
the school year is started.) For an elementary school with all courses that last all year the
following setup could be used. Replace the Starting and Ending dates with your schools dates.
“F  Elementary Demo icl %]

=chi# 0> Zchool Mame Afternate®  Sch Abry Telephone

|E|EIE Elementary Demo Elem 999-123-9876
Basic | cereral | Schedue | Envolment Term[hrﬂiml Localization |

Term | Title |Starting  |Ending |1 J2 J3 J4 |5 |6 J
1| %ear Schedule 09sa0  (0EM 4001 Ky
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Using the Teacher Atom

You use the Teacher atom (Basic Scheduling folder) to set up your teacher records. This is where
you enter professional information for each teacher and assign the teacher ID’s. After the
teachers have been entered, this atom can be used to assign a group of students to a specific
teacher.

Entering New Teachers
1. Open the Teacher atom within the Basic Scheduling atom.

Adams, Alicia X
Lazthlame <k Firzt Mame Middlle Mame Gnn Soc Sec ho Teh D
| Adams Alicia 18
Short name EmployeeNo Gen  Eth Expr Degree Couns Telephone Extn WMaibox
|.ﬁ.dams, &, - - - -
Home Foom Maxotu  Dept Dept2  Depts  Deptd iy Type
v v v v | v
License Number Email Addrezs

FIfeTi [ Ciose

2. From the Data Menu, select the ADD option or hold the Control key and press A. The
Teacher ID field will populate with asterisks. When you complete the steps listed and
save the next available teacher number in the system will replace the asterisks.

3. Type in the teachers last, first and middle names in the appropriate fields (Social Security
number is optional.)

4. In the Short Name field, type the teacher’s name as you would like it to appear on reports
where space is limited, and also on the first page of the student form in the Name field
next to the Tch #.

5. All of the other fields are optional and can be filled in as you wish.
6. Click SAVE to record entries, click UNDO to clear entries since the last save.

To Change Name, SSN, or ID
1. Open the Teacher atom within the Basic Scheduling atom then find the teacher whose
record you want to change.

2. Click on the Teacher menu; select Change Name, SSN, ID option from the drop down
menu.



3.

4.

Make the appropriate changes.

Click SAVE to record changes, click UNDO to clear entries since the last save.

Inactivating Teacher Records

1.

Open the Teacher atom within the Basic Scheduling folder, then find the teacher whose
record you want to inactivate

Click on the Data menu, then select the INACTIVATE option from the drop down menu.

Click SAVE to make the inactivation effective. Parentheses will appear around the
teacher’s name in the title bar to indicate an inactive status. Click UNDO to keep the
teacher active.

Reactivating Teacher Records

1.

Open the Teacher atom within the Basic Scheduling folder, and then find the teacher
whose record you want to reactivate.

Click the Data menu, and then select the REACTIVATE option from the drop down
menu.

Click SAVE to reactivate the records. The Parentheses around the teacher’s name in the
title bar indicating an inactive status will disappear. Click UNDO to cancel the
reactivation.

Deleting Teacher Records

1.

Open the Teacher atom within the Basic Scheduling folder, and then find the teacher
whose record you want to delete.

Click on the Data menu, and then select the DELETE option from the drop down menu.

At the prompt, “Ok to Delete Records?” click OK. To abandon the delete, click
CANCEL.

Deleting is permanent. If a teacher returns to your school, you will need to reenter all their pertinent information. Inactivating
a teacher keeps their information in you system, but flags the teacher as inactive. If he/she returns to your school, simply
reactivate their record.




Using the Course Atom

The Course Atom (Basic Scheduling folder) enables you to set up and maintain a record
for each course taught at your school.

If you wish to name the courses according to subject matter i.e. ART, ENG, MTH rather
than have SASIxp assign the next available numeric number you must open the Next ID
atom (System Setup folder) and change the ACRS file Next Course ID to 0 in the Next
Number field. Save, Close.

s

Lm | File Cnde| Description Mext Mumber |
J AC0OL Mext College 1D Mumber
[UE|ACOL  |Mext College Link
l_'r' ACR Mext Course 1D
[E|acTR  Next Sequence Number
[glacks  Next Clazsroom ld

10l ACHH  [Mest Seating Chart Id

Entering New Courses
1. Open the Course atom within the Basic Scheduling atom.

#= Reading X
Courze D < Course Title Long Course Title Duration
|RDG Reading Reading VR v
zen  Low High MY Credi flax Credit Weight Fee 1 Feg 2

| + 00 » 06 = -

Eff Date Exp Date Department College Frep Lng Tght Inst Type
| - - b -
Alternaste |0 1 _.ﬂ«rternate o2 _State I 1 _State 02 _Mass Change
Subject Areas College Areas University Areas

| - - - - - - - - -
Prerequisite Fegency Course Category  Qualifies for Aid  CBEDS Grp CBEDS Yoo E
| lu] - - - - -
“oc Program Yoo Course Duplicate:

| -

|+ | General Info E m I:

2. From the Data Menu, select the ADD option or hold the Control key and press A.

3. In the Course ID field enter the Course ID (chose a combination of
Alpha/Numeric characters) if the Next Course ID was set to zero. If not, this field
will be populated with asterisks and the next ID available will populate this field
upon saving the information.

4. In the Course Title field, type in an appropriate Short Title (18 char). This is the
title that will appear on schedules, report cards and transcripts.



5. Inthe Long Course Title field, type in an appropriate Long Title (40 char). This is
for descriptive purposes only.

6. In the Duration field, use the drop down list to select a term duration (YR in most
cases at the elementary level).

7. In the Gender field, use the drop down list to select a gender restriction if one
applies.

8. Inthe Low field, use the drop down list to select the lowest grade level allowed to
take this course.

9. In the High field, use the drop down list to select the highest-grade level allowed
to take this course.

These are the main fields necessary for elementary scheduling. The remainder of the
fields can be filled in for reference purposes. If the elementary is using grade reporting,
including GPA’s and transcripts, the credits and N/H fields impact the GPA. Refer to the
Grading Setup handout for further information.

10. Repeat Steps 2 — 9 to enter all remaining courses.

NOTE: If SASIxp Grade Reporting and /or InteGrade Pro are being used, all the subject

areas for which the student receives a grade will need to be added as a course in SASIXxp.

(i.e. Reading, Spelling, English, Math, Science, Social Studies, Art, Music, PE, Computers,
etc.)

Once you have entered all courses, you can open the Course List atom (Basic Scheduling
folder) to see a list of all courses.

#F  Course Lisk x
Course D |CDurse Title |Duratinn |
RDE Reading YR
MTH Math R
S Science ki
S0 Social Studies YR
SPE Speling R
U= husic N
ART At ki
Ciomd Computers YR
PHY Phy=sical Education N
EMG English R

[ Close |
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Using the Sections Atom

To Create Sections (For Primary Teachers)

Open the Sections atom in the Basic Scheduling folder. The atom will open to the Student List page.

From the Data menu, select the ADD option or hold the Control key and press A. Asterisks will appear
in the Section ID field immediately. These will change when the Course ID has been selected if
Course & Manual was selected in the School atom. Otherwise, the next available Section ID will
replace the asterisks when you finish with the steps below and click SAVE.

Click the blue quick link arrow to the left of the Course field. The Course List will position itself on the
far right side of the screen. Scroll down the list until you find the desired course. Position your mouse
arrow on top of the Course ID number, click and hold until an outline box appears. Drag the outline
box onto the Sections form and release. All appropriate Course information will automatically appear.
(If Course & Manual has been chosen in the School atom, the Section ID field will now be filled with
the Course ID followed by a hyphen — the actual section ID will need to be entered manually before
the new section can be saved.)

Enter the second part of the Section ID after the hyphen — Many schools enter the grade level such as
01, 02 etc.. For those schools with more than one grade level, often the teachers’ last name initial
followed by grade level is used, such as P1 for Piper grade 1 or J1 for Johnson grade 1. In the
example above, D1 would be added for Denise Duffel.

Click the blue quick link arrow to the left of the Teacher field. The Teacher List will position itself on the
far right side of the screen. Scroll down the list until you find the desired teacher. Drag and drop the
teacher number onto the Section screen just as you did for the Course. All appropriate teacher
information will automatically appear.

: e |
Section 1D <1k Period  Ending Term Lo Hi Max Tot M F  Opn Pre
|RDG-D1 01 - 01 =« YR - 01 - 01 - 30 30
Course Course Title Room Credit
Fr ROG Readlng 105
Tche Teacher = Bo Cver Excl & Excl Grd Gen Op Trm House  Team Zwwner
B 5 Duffel, O - -
Lng Tg Inst Tvpe
= Xl
Student ID Iauderr\L CourseID | Course Tile Durstion
Reading _
= Teacher Lisk X hath gy
Toh# | Mame | Science i
18 [Adams, Alkia ] Social Studies i
25 |Barrow, Bl = Speling TR
121 |Beck, Wendy I Music ¥R
31 |Burke, Michelle At VR
|_' Computers YR

19 |Callison, Carrie
119 |Callison, Cindy

10 |Eldridge, Elizabeth
15 |Hughes, Heather

Physical Education YR
English YR

| Ele

6.

Fill in the Period (beginning) and Ending from the drop down menu. This should be entered according
to how you want the courses to show on the class schedule or report cards if using SASIxp grade
reporting. For example 01 to 01 will print first, 02 to 02 will print second.

11



7. The Lo field should be filled with 01 for grade one and the Hi field with 01 for grade 1.
8. The Max field should be filled with the maximum number of students allowed in the class.
9. The room number for the teacher can also be added.

These are the fields that need to be entered. Any others can be added later if the need arises.

To Duplicate Sections (For Primary Teachers)
Keeping the Sections atom open, the Course List atom open, and Teacher List open, you are now
ready to create sections for all grade levels. It is easiest to enter all sections of one course at a time.
For example, since Reading RDG was chosen first, all courses of RDG should be added. Be sure to
add one for each teacher.
1. From the Section menu, select Duplicate Section.

The section created on the previous page will now appear as below.

Ix

Reading / Per. 01 :
Section 1D <Ak Period Ending Term lm H Max Tot M F Opn Pre
|RDG- 1~ M1 « YR 01 = 01 - 30 30
Course Course Title Room Credit
F RDG Reading 105
Tch# Teacher Mame Mo Cwr Excl A/ Excl Ged Gen Op Trm Houze  Team Chener
5 Duffel, . - - - -
Lng Taht Inst Type

| - -

Studert ID | Student | Grade | Start Date | Tis ] Override J

- |
|
- |
- |
|

[ [Student List HEy | H |

2. From the Teacher List atom (still open on desktop) drag a new teacher onto the Tch# field. The
new teacher number can also be typed into the Tch# field.

3. Enter the second part of the Section ID (after the hyphen) with the same identifier as used above.
In the example shown, since the new teacher’'s name is Alicia Adams and she teaches first grade,
an Al will follow the hyphen: RDG-AL.

4. The Lo and Hi fields should be modified accordingly. When the second grade teacher is added to a
section, the Lo and Hi fields should be filled with 02.

5. The room number for the teacher should also be changed.

6. Repeat Steps 2 -5 (Duplicate Sections Primary Teachers) until all sections of Reading have been
created.

Continue creating the next course by following the steps outlined in the “Create Sections for Primary Teachers”
area on page 10-11.

12



To Create Sections (For Special Teachers)
Repeat all steps for creating sections for primary teachers, except when entering the manual part of the Section

ID, enter the same ID used for the Primary Teacher. For example, the Section ID for Art would Be ART-D1 for
Denise Duffel and ART-A1 for Alicia Adams.

To Duplicate Sections (For Special Teachers)

With the appropriate Section open (in this case ART), Select Duplicate Sections from the Sections menu.

The following window will appear.

Art / Per. 08 Sections =
Section 1D <k Period Ending Term Lo Hi Max  Tot M F  Opn Pre
[&RT- 05 ~] 08 + R = 01 06 « 30 30

Course Course Title Room Credit
Fr ART Art ART

Tch# Teacher Name Mo e Excl A/ Excl Grd Gen Op Trim House  Team (s aT=l]
F* 15 | Hughes, H. - - - - -

Lng Taht Inst Type

| - -

(= [Student List | Undo |
The only field that needs to be changed is the manual part of the Section ID. There
should be a section of Art created for each primary teacher in the school.

To View / Edit Sections

1. Open the Sections atom. In Find mode, type an asterisk in the Section ID field. Click
FIND.

A Matrix of all sections like the one below will appear.

13



el
Section D |EEC| End| Trm |Crs ] |Course Title |T|:r| Teacher Name |F:|:|om| Max| Tat |Opn |
MTH-D1 04 |04 YR |MTH hsth 5 |Duffel, D. 105 30 30 E
LIS-21 07 |07 YR MUz Music 24 |Mord, M. MUS | 30 a0
MUS-D1 07 |07 YR MUz Music 24 |Mord, M. MUS | 30 a0
MUS-E2 07 |07 YR MUz Music 24 |Mord, M. MUS | 30 a0
PH 21 10 110 YR |PHY Physical Education | 29 |Kirk, K. GyM | 30 a0
PH-[v1 10 110 YR |PHY Physical Education | 29 |Kirk, K. GyM | 30 a0
PHY-E2 10 110 YR |PHY Physical Education | 29 |Kirk, K. GyM | 30 a0
ROG-A1 M |0 YR RDG Feading 18 |Adamsg, A, 106 30 30
ROG-D1 M |0 YR RDG Feading S |Duffel, D. 105 30 30
ROG-E1 M |0 YR RDG Feading 10 |Eldridge, E. 107 30 30
=SC1-01 ns |05 YR |=CI Srience 5 |Duffel, D. 105 30 30
S0C-D1 06 |06 |YR (SOC Social Studies 5 |Duffel, D. 105 30 30 =
SPE-A1 02 |02 |%R |SPE Spelling 18 |Adams, A, 106 30 30 3
SPE-D1 02 |02 |%¥R |SPE Speling 5 |Duffel, D. 105 a0 a0 E
19 Zections inthe list | I

If something is missing or wrong in this list, double click on the Section ID to view or modify a
particular section.

To Find sections for a certain teacher: In Find mode, enter the teacher number in the Tch# field
and click FIND. A matrix like the one above will appear, including only sections assigned to the
specific teacher. A different matrix will appear with the selection of different parameters.

To Create Lists of Students to Enter into Teacher Sections

Once all sections have been created, the easiest way to create Student Schedules is to add the
students to the sections that they will be a part of.

1. Open the Student or Enrollment atom.

2. Perform a Find using criteria designed to produce a matrix that includes the students you
want to enroll in certain sections. For example a matrix of all the 1% grade students.

CEE— >

Lazt fame <k Firzt Maime Micldlle tame Goin Grd Gen Etucdent 1D
[ | Y01+ +

Page 1 | page? | Pagez |

3. Holding down the Shift key, click each student ID in the Student (Enrollment) matrix that
you are going to add to certain sections. Release the Shift key and drag and drop all of the
highlighted students onto a blank area of the desktop. A new atom will be created for this
list of students.

14



£ Student List %]

Studert D | St| Last Name | Firat Mame | Middle | Grrtn | Gra| Ger| Birthdate

11 Addicks Amber M F|082084
E] | _--ﬂ
B e |awarez I N

09524134

o4 8

51 Arain F{Dh'fn o ofF

5 Arellano Kelly o1 o|F (050694
- Lrniolcl I'I'r 1492
BEI Azfaur o1 |F (04430094

Elenjamm
DT oo o S———
133  |Berkes R'fan 01 S~
K |

hike: (list)

To rename the Mike (list) atom, close all forms on your desktop. Highlight the Mike (list) atom
and from the File menu choose Atom Info.

The following window will appear.

| ¢

Atom Inho

Change the Name Mike (list) to the

Mame: hiike (list) class list of the teacher whose

| students have been selected. I.e.
Duffels D11% grd stu list

short Mame:

Basic | Atom Details

e | A Description may be added if

Type: |Data &tom wished.

Hotkey: cirl - =hift + |

@ [ Locked
| | |

Repeat Steps listed above to create Lists for all students.

To create a “Student Class Lists” Folder in which to store all of your lists, go to the File menu
and select New Folder. In the Save As field, type: “Student Class Lists” and click SAVE. Once
the folder is created, you can drag and drop the student lists onto the new folder.

15



To Enroll Students into Classes
1. Open the Section atom.

2. Perform a find to produce a matrix listing all sections for an individual teacher.

This can be done in one of two ways. If you only wish to list the Primary teachers sections
(classes) enter the primary teacher’s number in the Tch# field and click FIND. The following
matrix will appear.

|
03 YR |ENG Englizh 5 |Duffel, D. 105 | 30 30
04 YR |MTH hath 5 |Duffel, D. 105 | 30 an
M YR |RDG Reading 5 |Duffel, D. 105 | 30 an
05 |¥R |5C Soience 5 |Duffel, D. 105 | 30 30
05 YR |30C Social Studies 3 |Duffel, D. 105 | 30 a0
02 YR |SPE Speling 5 |Duffel, D 105 | 30 30
[E]

B Sections in the list

If you wish to list the Primary teacher’s sections (classes) along with special teacher’s sections
(classes) enter :D1 in the Section ID field. The wildcard “:” is used to find entries which
contain certain characters and D1 is the manual part of the Section ID that represents Denise
Duffel’s sections (classes).

= x|

Section D <l Period  Ending Term Lo Hi Max Tot M F  Opn Pre
kD1 | + + + + |+ |
Course Courze Title Room Credit
P
Click FIND
The following matrix will appear.

Section List Sections X

05 YR ART Lt 15 Hughes, H. ART | 30 30
09 YR COM Computers 9 |Jones, J. MEDIA 30 a0
03 YR ENG Englizh 5 |Duffel, D, 105 | 30 30
04 YR MTH Math 5 |Duffel, L. 105 | 30 30
o7 vRMUS Music 24 |Mord, M. MUS | 30 30
10 YR PHY Physical Education | 29 |Wirk, K. GYM | 30 30
M YR RO Reading 5 |Duffel, L. 105 | 30 30
0s YR |SC Science 5 |Duffel, L. 105 | 30 30
06 YR S0C Social Studies 5 |Duffel, D. 105 | 30 30
02 %R |SPE Spelling 5 |Duffel, L. 105 | 30 30

16



3. Regardless of which Matrix you choose to use, double click on the first Section ID. This
will open the Section where the students will be enrolled.

English / Per. 03 Sections El
Section I Ak Period  Ending Term lo Hi Max Tot M F Opn Pre
|ENG-D1 03 = 03 = YR« 01 = 01 - 30 30

Course Course Tithe Room Credit
B OENG Enalish 105

Tech# Teacher Mame Mo Owr Excl At Excl Grd Gen Op Trm House  Team Oy ner
F 5 Duffel, D. - - - -

Lng Toht Inst Type

| - -

Duffels List 1st Grade

|+ |Student List

4. Drag the correct student class list atom onto the section, in this case drag Duffels List 1
Grade atom onto the section “Student List” page.

5. The students in the atom will be added to the Sections atom.

The students are added to the matrix in the Sections atom in alphabetical order.

The system date defaults in the Start Date cell for that student. If this process is done before the
start date on the term duration page of the School atom the date will default to the date selected
there. If the school year has already started you can mass change this start date later. (HINT: You

can temporarily change the system date to the first day of school if you are adding numerous
students.)

The students will be enrolled into the section as shown below.

English / Per. 03 Sections ﬂ
Zection I <= Period Ending Term le Hi  Max Tot WM F ©Opn Pre
|ENG-D1 03 = 03 = %R - 01 = 01 » 30 | 12 9 9

Course Course Tile Room Credit
Fr ENG Englizh 105

Tch# Teacher MName Mo Owr Excl At Excl Grd Gen Op Trm House  Team Crvner
F* 5 | Duffel, D - - - - -

Lng Tagkt Inst Type

| - -

Aguilar, Mike &, 09500
Alvarez, Janeil o1 090500
Arnold, Ryan o1 090500
Banas, Ryan (Jude) J. o1 090500
Biattish, Lauri J. o1 090500

[+ [Student List
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6. Close this section.
7. Repeat steps 3 — 6 until the students have been enrolled in all the sections for this teacher.

Once all students have been enrolled for this teacher, you are ready to repeat the above process
for the remaining primary teachers and special teachers in your school.

To View a student’s schedule
1. Open the Classes atom (Student Info folder, or Basic Schedule folder)

2. Find the student whose schedule you wish to view.

E  Aguilar, Mike A. E |
Last Mame <] First Mame Miclclle Mame Grd Gen Student ID
Aguilar ke 2 o1 ha 13
Ln | Sec D | EIe-:| End| Trm | crs D | Course Title | Tch | Teacher Mame | Room

j ROE-O1 (01 |01 |YRE RDEG | Reading 5 |Duffel, D. 105

ﬂ SPE-D1 (02 |02 |YR |=PE Spelling S |Dwuffel, D 105

ﬂ EmG-C (O3 |03 |YR |EMS  |English 5 |Dwuffel, D 105

ﬂ MTH-O1 |04 (04 |YRE (MTH  |Math 5 |Duffel, D. 105

ﬂ SC-D1 |05 |05 |YR = Science S |Dwuffel, D 105

ﬂ SO0 (06 |06 |YR O (S0C | Social Studies 5 |Dwuffel, D 105

ﬂ fUS-D (D7 (0F |YR (MUS | husic 24 |Mard, M. U

ﬂ ART-D |08 |08 |YR (ART A 15 |Hughes, H. ART

ﬂ COoOM-D1 09 09 |[YRO|COM [Computers 9 |Jones, J. MED! 2,

ﬂ PHY-D1 (10 10 |¥RE |PHY  |Physical Education) 29 |Kirk, K. G m

Dizplay Claszes for Term: |,u,||

= [Classes [ (= | Close

3. From the Classes menu select CLS32 to print class schedules.

4. Class Rosters can be printed for individual sections from the Student atom. Open the
Student atom select Class Rosters W/Sched (STU41) and choose to print individual
sections or all sections for a certain teacher.

To Create Lists of Sections (Classes) for Scheduling New Students

Before scheduling an individual student, the following steps should be followed. Teacher Class
List atoms should be created in a similar fashion to creating Student List atoms.

1. Open the Section atom.

2. Perform a find to produce a matrix listing all sections for an individual teacher. If you
want to include the special classes in a student’s schedule, you can enter the “contains”
wildcard colon preceding the manual part of the Section ID that represents the teacher’s
sections (classes). For example, to create a list of all sections taught by Denise Duffel,
enter :D1 in the section ID field when performing a find.
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O x|

Section 1D > Period Ending Term lo H  Max Tof M F Opn Pre
[ + + + + o+ |
Course Course Titke Room Credit

P

The following matrix will appear:

“¢  Section List ions X
Section D |EIec|End|Trm|Crs D |Ccuurse Title |TcF|Teacher Mame |Rnnm|Max|Tnt|Opn |
ART-[v 0a |08 YR ART Art 15 |Hughes H. ART | 30 an
COM-D 09 |09 %R oM Computers 9 |Jores, J. MEDIL 30 an
ERG-0r1 03 |03 YR ENG English 5 |Dutfel, D, 105 3o an
MTH-Cr1 04 |04 YR |MTH Math 5 |Dutfel, D 105 3o an
MLIS-Cr1 o7 07 %R MUS Music 24 |Mord, . MUS | 30 a0

PH -[r1 10 10 ¥R PHY Pheygical Education | 29 | Kirk, K. Gyt |30 an
RDG-D1 MM %R |RDG Reading 5 |Duttel, D, 105 a0 an
=1 05 |05 YR (|SCI Science 5 |Dutfel, D, 105 3o an
S0C-D1 06 |08 %R |S0C Social Studies 5 |Dutfel, D 105 3o an
SPE-DH 02 |02 ¥R |SPE Speling 5 |Duitel, D, 105 a0 a0

|

3. Holding down the Shift key, click on the “Section ID” title. This will select or highlight
all the sections (classes) in Denise Duffel’s section list. Release the Shift key, place the
mouse over any of the beginning period fields, click and hold to see a shadow box, and
then drag and drop all of the sections onto a blank area of the desktop. A new atom will
be created (named for the first section selected from the Section matrix). In this case, the
atom is titled ART-D1 (list) 1. Close all forms on your desktop and follow directions
previously outlined to rename the atom.

Repeat Steps listed above to create all teacher class lists. Then create a new folder to keep all the
class lists in.

NOTE: After creating new atoms, from File in the menu bar select Save Desktop.

To Assign a Schedule to a New (Individual) Student
1. Open the Classes atom (Student Info folder, or Basic Scheduling folder).

2. Find the Student for whom you wish to schedule classes.

3. Select the correct Teacher Class List atom from those you have created and drag this
atom onto the Classes atom. The student will then be scheduled into all the sections
(classes) that are assigned to this teacher.
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~r Addicks, Ambs x|

Last Mame b First Mame Micdle Mame  Grd  Gen Student ID
|Addick3 Amber W 01 F 11
Ln | Sec D | Elecl Endl Trm | Crz D | Course Title | Tch | Teacher Name | Room |
ﬂ RDG-D1 |01 |01 |¥R |RDG  |Reading 5 |Duffel, D. 105

[Z|srED [0z [02 [YR [SPE  |Speling Duffel, D.
[3]enc-D1 |03 [03 [¥R [ENG  [Engiish Duffel, D.

= = Teacher Class Lists

: i
ﬂMTH-D1 04 04 (YR MTH  |Math 5 |Duffel, D.

]

a

[5[sc |05 08 YR |SC Science Duffel, D

ﬂ SoC-D1 |06 |06 YR |S0OC  |Social Studies Dufiel, D. Dufiel D1|333 List (5)
[7MuUs-D1 |07 07 YR |MUS  |Music 24 |bord, M.

8| 2RT-D1 08 08 |YR |ART |ad 15 |Hughes, H.

ﬂcom-m 0a 09 YR O|COoM | Computers 9 |Jones, J Ly,

[A@[PHv-D1 (10 10 |¥R |PHY  |Physical Educstion) 29 |Kirk, . Eldridge E2 Clazs Lizt (10)

Dizplay Claszes for Term:  [a) -
o

|: | Claszes E III Adams &1 Class List (18)

4. Click Save if this schedule is correct.

5. The start date will automatically default to the system date. If this student is scheduled
before school begins, the start date will be determined by the start date on the Term
Duration Tab of the School atom. If you need to change the start date for the individual
student, click on the Classes menu, select Show Start Dates. A new column will appear
and the dates can then be manually changed.
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Elementary Scheduling ~ In Practice

Warren Consolidated Schools
Building Level documentation

By: Janet Cameron
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Elementary Scheduling

Create ToolBar for Elementary Scheduling

Utilities Folder
Query Atom
Generic Selection
Basic Scheduling Folder
Sections
Teacher List
Course List
Classes

Click on Query Atom

Create the following filter changing the grade to the appropriate
grade.

KEEP ASTU if GR =00 and Status = * *

Click on Sections Atom
Find section number for first Kindergarten class

Open Generic Selection and arrange windows on screen

=+ SASkxp [_[5]x]
el

- GRADE KK / Per. 01 Sections |4
Section D 4D Period_Ending Term Lo M Max To M_F Opn Pre
0001 O v 01 v VR Y Y05 w2s (24 8 150 0
Course Course Thle Rooin Credit Jes
B oo GRADE KKt 105 100
Toh#_Teacher Name Mo Owr Exol Att Excl Gre Gen Op Trm House Team owner [TE
. 175 SAEG,5 v - CI -
School 5f Choloe Lng Taht_Inst Type

Studert List | Dropped Students |

Search File
[ASTU - Student

[Selections (25)

StudentD | Studert | Grae | start Date | T8 | Overrice |
e

hiathis, Alyssa
Parrish, Misty Marie
Saba, Saba Luke Sami

Thorpe (THO059) Vear: 02 03 User: SASI Date: 0017/02 Security omcer‘

|
[arren Carmsolidated SO @ ‘ |
ghstan | | @ et vonitor a1 | B Groupivise-Mal [ 5ASInp T Misosoftword - | Effsession -1+ | ||| § Ete 723am




10.

Double click on the names on the left side of the screen that you
wish in this section.

Once you have all the names on the right for this section, click on
the Blue heading that says Selections (25) on the right side of
the screen. This will highlight all the names.

Click and hold the mouse button until you get the marching ants and
Then drag the names over to the Section in the upper right
Corner of the screen and drop it on the sections.

Repeat this process for all sections in that grade level.

When grade level is complete, remove filter from System Filter
Folder.

Repeat steps 2 — 7 for each grade level.

When completely finished make sure all filters are removed from the
System Filter Folder.

In Sections, click on Sections on the Menu bar at the top. Click on
Update Counts.

23



ELEMENTARY SCHEDULING FOR REPORT CARDS:
(4™ & 5™ Grade Pilot only)

Complete the first ten steps above for all grades.

Open Mass Assign Classes Atom in the Basic Scheduling Folder.

=l Mass Aszign Classes B
Search List [2 section Lookup Add List [= section Lookup
Enter zection(z] to locate in Erter section(s] to add, or to replace those
Student Schedules in the Drop List.
Section I | /Course Title | &ction) Section I | Course Title
040 GRADE 04 Drop o&rt-42 At

Comm-4.2 Camm

Cond-44 Conduct

Heal-4.2 Hesalth

Larng-4.4 Language

Math-4.8 M=tk

huzi-4.4, huizic

Plrys-44 Phys Ed
Fead-4.2 Read
Scie-4.2, Science

[F] |Socs-4a [Social Studies

Mate: For & drop or replace to take effect,
the studernt must have all sections inthe drop list

Grade level: *|  Gender: -

Query Statement (optional)

Starting Date for Mew: Classes nes26m3] |

[ Record Changes in Class History.

[ Close [ assian § I

Lean Elementary (LEA-050) Year: 03-04 User: SASI Date: 0609093

On the left side, Search List, click on the Section Lookup Arrow at the
top and select the section for Teacher A for the 4™ Grade Section.
In this example from Lean, Teacher A is teacher #102, Carpenter.

On the right side, Add List, click on the Section Lookup Arrow at the
top and select all the sections for 4A except Band. Those will have to
be individually scheduled.

Fill in the start date of 08/26/03.

Click ASSIGN.

Repeat this process for 4™ Grade Teacher B and Teacher C
Repeat this process for all 5™ Grade Teachers.

In Sections, click on Sections on the Menu bar at the top. Click on
Update Counts.
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Elementary Scheduling ~ In Practice

Utica Community Schools
Building Level documentation

By: Kathy Werner
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Elementary Procedure for Assigning Students to Classes

1. Log into the new school year (2006)

2. Open the Sections Atom
Select Sections dropdown menu from the grey bar across the top
Select MSTO2 report

File Edit ‘Windows Data | Sections Help

TS, runu o bections x
4] ]| sectionn Update Counts Lo Hi Max Tot M F  Opn Pre
———— | |oooz2 Drop Student ~06»35 [19 10 9 16 O

% F}i@“rse Sections List (M3T0Z) e

Sy= Admin ookP Totals by Course [0 {M3TO) 1.000
T.-_ﬁh# Le: Class Load analysis (M5T12) Grd Gen Op Trm House  Team Oyner
Y Tehr Sched (MST25) - Mo Rat. - = b
Lng Taht Ins .
- Tehit Sched (MST2S) - Rotation
Uik SEEy Class Listing (MST24)
Shudentl  Open Period Day Comb (MSTS1)
CLS Analysis -Per/Crs(MST21
Studert ID nalysis -Per/Crs( ) & | Start Date | T/t | Override
SIS Duplicate Section
— (hange Section ID

El JE— |

Reorg Files g
=
_ =
Ot Temp File f
j=—=F - 1

3. Change the report to the MSTO3 report
Print the MSTO3
Make all corrections to the teachers/sections/rooms etc. on the report.
Make the same corrections in the sections atom.
If a teacher changes, make additions/deletions in the teacher atom.

File Edit ‘Windows Data Sections Help

Eg) e,
[« D] [ Tt~ = ol
== . x|
@ Section [0 Period Ending Term lo H Max Tot M F opnpPre |
Bhp Rt o002 02 v YR w ~0E~3E (19 10 9 16 O
Xl b

Fepart ID MSTO2 Recommended

Oriertation

MASTER SCHEDULE LISTING

¥ . Report Interface

Enter Print Criteria for Se

Teacher coyrse Range:

MSTOS: by Teh 1D, Period, Crs D

Tabl
i Teacher Range: - |—

-1

METOE: by Room, Petiod
METOT: by Tch Mame, Period, Crs D

Period Range:
Masz

[~ Cover Page Ef
[ Drat print
[ Preview

——Te & =T
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Open the Sections Atom
Find the section/class you are ready to assign students to
Drag the open section to the bottom right of your screen

=18l
Fie Edi Windows Data Sectons Help
Maintenance E
[ b O @
Guery T et —
P g S8 Modles
o2 Torya (ist)
Sys Admin Davis Eculog wittailsddr E &
@ Eclulog Quiery
Update Seat: Section: x|
SectionID_4b Period_Ending Term Lo H Mex Tot M F Opn Pre
|ood 00w YR w ~06 w35 (20 14 & 15 0
<A Course Caurse Tile Room Credit
sections F ooka AM KINDERGARTEN 18 1.000
Toh#_Teacher Nam: No Ovr Excl Mt Excl Grd Gen Op TrmHouse  Team Crener
@ [> 40 Evans am - - - - -
Reory Fies Lng Tght_Inst Type
@ stentist | Dropped Sterts |
DitTempFile Student ID Student | Grade | Start Date | Tia ) Gverride |
e - —
|GPra Exch. T
maE
I Morgan Elementary (014014 Vear: 06-07 Dser: SASI Date: 640606 Security Officer
[uTica csp ‘ % |
i start J @ 3 W = =@ @ ] @ sasixp 8 Document1 - Micrasoft ... J i @‘ [ Cg =21 am

Open the student atom
Select FIND
Place an * in the last name field
Select the grade level you’re working on from the dropdown grade field
Select FIND (all students in that grade level will appear in a matrix)

Hold the Shift key down and select the students that are assigned to the
first section/class that you have open. Drag the highlighted names
to the open section. (The student names will now be listed in that
section/class)
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=1®ix

File Edit ‘Windows Data Student Help

=]
=
B
4

I Bl = X @
#  Student List Student x|| &P T r’\ (list)y 1 =
Ea Py g SAS| Modules
Student ID Sta | Lact Name First Name Micidle: Grrtn | Grdl Gen | Birthda Tonya (list)
4656 Armstrong Ay o0 F Eduiog Guery MISDxpH.chm
a7 Bartold
e [ |Belanger |
434| Bicndo [ e —
157 Blanchard Collin 00 M 037 :5 32" i s 1:’" Ure
(EA) ] [poocen Tackery o M|
Tabtes 1098 Devitte Ashley o F e
444 Gehle Joseph 00 (b 090144
,—m-m e 0572240 1 Op Trn House  Team Cree e
@ 1158 Kramer Emmales oo |F ™ =
Next I 1637 Marku Isahella w F
s, [ Ciose || open_ | F—_—
TI2[Agrusa, Saran 1 TI04/06
® of 653 Belanger, Juianna fili] 09M04/06
435 Bogclen, Zackery [il] 09/04/06
Query 436 Jarvis, Mexander oo 090406
mEE
HE Mot yan Elettictitary (012014} Year: 06-07 User: SASI Date: 040606 Security Offices
[Grace % |
@ [
Jt!StartI j & @ W = =] 9 J @ sasixp ] Document1 - Microsft .. j e @‘ [N SE e3¢ am

6. If you need to take a student out of a section/class, select the student, go up to the
sections dropdown and select Drop Student. A box will appear, select Delete
permanently (No History Record) SAVE

7. Repeat for each section/class and grade level.

8. Stay in the sections atom, select Sections from the dropdown and choose Update
Counts. (must be on a section when updating counts)

9. Print new MSTO3 to verify master schedule.
10. When finished, run the following two queries to place the teacher number on the

student screen in the Tch/Advisor and Counselor fields.
These queries will also fill in the teacher number field on the enrollment atom.
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(= Query X
[cHAMGE [ASTU ACLS AMST Counselor = Tohhuml
# | Counzelor Mumber | Teachet Mumber |
| | |CIaSSLink | Conditions
IF [
|asTU vl1 [zcis 2 |amsT - | vlq | %
Telephone 4| |Status 4+ |ClazsLink 4| AND =
Birthplace Schoolbume | =] |SectioniD = EET
Birthieth =| |StuLink= BegPeriod =
EngProf ClazsLink= EndPeriod <
PrimaryLng StartDate SplitBeg :_
HomelLng EndDate SpItEnd P ﬂ
HomeLngCor Tchiide Track
504 AddTag TermCode Warighles
Freeieals hrgGrdCrs Courze= 2? i
UsCitizen CwerTermiCd CreTitle ) E
Counsslor EE [T ] o L
[ Show Inactive Records
[T Showe Empty Records | | I l
(5 Query X
[CHAMGE  + [ASTU ACLS AMST Advisor = Tohhu
# | Advizor Mumber | Teacher Mumber |
| | |CIaSSLink | Conditions
- - - - IF 2]
[asTU 1 |acLs - EEN | soRT |
Birthplace Status 4#| | Clagslink AND =l
Birthitvisth Schoolhume | =] | SectioniD L
EngProf Stulink= BegPeriod =
PrimaryLng ClazsLink= EnciPeriod <3
HotmeLng StarDste SpltBegy :=
HomeLngCor Encilate SplitEnd v ﬂ
S04 Tehaide Track
Freetesls AddTag TermCode Wariables
L=cCitizen MroGrdCrs Courses zﬁ' ﬁ
Counselors CrverTermicd CraTitle w2 =
| | OwerF A, 4+ w3 il

[ Show Inactive Records
[ Show Empty Records
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